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Preface

This tutorial describes the basic features of Familias. The current version of the tutorial 
is based on version 3.3, but should work reasonably well for versions 3.2.2 and 
upwards.

For a more comprehensive description and theory we refer to the manual (not 
updated) available at http://www.familias.no or publications listed at the 
indicated link.

For  Spanish translation of the current document please see 
http://familias.name/tutorial/familias_tutorial_spanish.pdf 

For videos including solutions to exercises in Egeland, Kling, Mostad (2015), see     
https://familias.name/VideosBook.pdf
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1. Basics. A paternity case in four steps
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Input file: tutorial-Ch1.fam

http://familias.name/tutorial/tutorial-Ch1.fam


Example used to introduce Familias
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Interpretation: The data is 4.4 times more likely if H1 is true rather than H2.
We next explain the steps needed to verify the calculations using Familias.



Four basic steps
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1. General DNA data. Input of database, i.e., allele frequencies, etc.
2. Persons.  Individual needed to define pedigrees.
3. Case DNA data. Marker data. 
4. Pedigrees. Define hypotheses and do calculations.



Step1: General DNA data
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• Click ‘Add’ to enter a marker. In the new window, enter as shown.
• Similarly for next marker TPOX with alleles 8 and 9, frequencies 0.554 and 0.104.
• The order of markers can be modified by using “Move up” or “Move down” buttons.  



Step 1 in detail: General DNA data
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The “New marker” window opens Click 

2

Add the name of the first marker (D3S1358 in the example) 3

Add the first allele (17), frequency  (0.204) and press ‘Add’ 4

Do the same for the second allele (18, freq. 0.1394) 5

Click ‘Save’ and it will appear: 6

For “Scale”, click yes (the freq. of both alleles will 
change to sum 1) 
For “add a rest allele”, click No (a rest allele with 
freq. 0.6566 will be added)

7

Repeat the process for the second marker (TPOX, in the example) 8

Click 

1



Step 2. Persons

Familias - Tutorial 9

• Enter the persons: AF (alleged father), and CH (child) as shown.
• Information on ‘Role’, ’Year of birth’, ‘Is child’ and ‘Is parent’ are  normally 

not needed nor used. Is parent is currently not used in any routine.
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Step 2 in detail: persons

Click 

1

Enter the name of the first person (AF) 2

Optional: enter the year of birth 3

Enter the gender 4

Click ‘Add’ 5

The “Persons” window opens 

2
3

4
5

Do the same with the following person (CH) 6

Comment 1
If you enter the year of birth, you make sure 
that a younger person can not be the parent of 
an older person (useful to avoid errors in the 
pedigrees and impossible pedigrees)

Comment 2
If you click the “Is child” box, you make sure 
that this person cannot have children (useful 
for the same reasons as before)



Step 3. Case data
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• Double click each person. In the new window select the marker in 
the pull down menu, press ‘Add’ and ‘OK’, to enter the data as shown.



Step 3 in detail: Case data
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Click 

1

The “Case-related DNA data” window opens 

Double Click  (AF)

2

Select the marker (D3S1358) 3

Enter the genotype (17-18)4

Click ‘Add’ 5

Do the same for TPOX and then close 6

The “Add/Edit DNA data” window opens 

3 4 5

Repeat the process from         for CH7 2

Comment
If you want to consider dropout in one specific 
individual, click the box. See slide 18 to enter the 
probability of dropout  



Step 4. Pedigrees
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• Click ‘Add’ to enter the hypothesis “H1:Father” as shown (upper panel).
• Enter the pedigree “H2:unrelated”. In this case no relations are added.
• Click ‘Calculate’ to get the output in the lower panel.



Step 4 in detail: Pedigrees
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Click 

1

The “Pedigrees” window opens Click 

2

Name the pedigree (e.g., H1: Father) 3

Define the relation (AF father of CH)4

Click ‘Add’ 5

Name the second pedigree (H2: unrelated). You 
do not have to enter any relation in this case  

6

Click ‘Close’ 7

The “Add Pedigree” window opens 

3

4 5

Comment
Familias only allows you to define 
parent-child relationships. If you 
want to define the relation “2 
brothers”, you have to enter a 
mother and a father and establish 
that both are sons of them.  
In order to define a disputed direct 
match, e.g. twins, use the 
Direct/Identity option

7

Then click ‘Calculate’ in the 
Pedigrees window to obtain: 

8



2. Complications
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Mutations
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Click 

1

Click 

2

34

• Enter Step 1 (      ), the Database window and press ‘Mutations’ (      )  to get the above 
window.

• There are five models as shown (see the following slide for more info)
• One can assign the model to all markers (      ) or only the ones selected (      ) as shown. 

1 2

3 4



Mutation models in Familias

Familias - Tutorial 17

- Simple model
Each mutation has an equal probability of occurring. Appropriate for fast 
computations (e.g. complicated pedigrees and DVI) as well as for SNP markers.

- Proportional to frequencies
Each mutation has a probability which is proportional to the frequency of the allele 
we are transitioning to. A low frequency will yield a low mutation probability. 
Appropriate for testing of statistical properties of calculations.

- Stepwise model
The traditional stepwise model where the probability depends on the number of 
steps from the original allele to the mutated allele, decreasing probability for 
longer repeat mutations. Appropriate for STR markers without microvariants.

- Stepwise stable model
The traditional stepwise model where the mutation probabilities have been 
adjusted to create a stable mutation matrix. Appropriate for testing of statistical 
properties of calculations.

- Extended stepwise model (RECOMMENDED)
The most complete stepwise model, where both exact repeats as well as 
microvariants are accounted for. Appropriate for all STR markers.



Silent alleles and Dropout
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Click 

1

4

5

• Enter  the Database window (      ), double click the marker to edit (      ).
• Clicking Options (       ) gives the above window where the silent allele  frequency (       ) 

and/or Dropout probability (       ) can be entered.
• For Dropout , further input is required in the Case DNA to specify the individuals 

susceptible to dropout (see slide 12).

1 2
3 4

5

Double Click 

2
3

Comment 1
Note that 
changing the 
Database size 
won’t affect 
the results. 
Comment 2
Defining a 
non-zero Min. 
allele 
frequency only 
takes effect 
once Advanced 
option is 
checked



Inbreeding: Complex pedigrees

• Draw pedigree

• Identify extra persons needed to define the pedigree.

• Enter required persons (Step 2) and pedigrees (Step 4).
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Comment: Persons 202 and 203 above are not needed, but plotting 
functions will introduce them. The double lines connecting 101 and 102
indicate inbreeding, i.e., parents are related within the pedigree.
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Theta correction
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Click 

1

Click 2

• Click ‘Parameters’ in the Pedigrees window (      ) . Above the value 0.01 is entered (      ).
• ‘Prior parameters’ are virtually never changed: they have no impact on LR, only on the 

prior (and hence the posterior). 

2 3



Some further options in the Pedigree window
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Generate pedigrees, see next 
slides

Choose prior for H1 and H2,
only affects posterior

Plots pedigree, see Section 3

Choose markers to exclude
for calculations

Select denominator of LR:
marking H1 and pressing scale
gives LR for H2 vs.H1

Imports pedigrees, see next page
Exports pedigree file



Creating pedigrees in QuickPed, import to Familias
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● The next slide shows how the app QuickPed (Vigeland, 2022), an online 
tool for drawing pedigrees and analysing relatedness, can be used to 
create pedigrees.

● The pedigrees can be imported to Familias as explained next.

https://magnusdv.shinyapps.io/quickped/
https://bmcbioinformatics.biomedcentral.com/articles/10.1186/s12859-022-04759-y
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1. Create pedigree in e.g. QuickPed  https://magnusdv.shinyapps.io/quickped/ 
2. Save ped file from QuickPed
3. Optional look at ped file tutorial.ped
4. Import tutorial.ped to Familias
5. Ped file in Familias

https://magnusdv.shinyapps.io/quickped/
http://familias.name/tutorial/tutorial.ped


Export from Familias to QuickPed and plot
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1. Highlight pedigree. Pedigree must be connected, i.e., none or both åparents 
must be present

2. Hit `Export`
3. `Load file`  in QuickPed

1

2

3



Generate pedigrees
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Comment
See ESWG proficiency test  for 
2021: exercise with video and 
presentation

Question: What is the relationship between four children? 
Full siblings, half siblings or unrelated?

Define children 
(cannot be 
parents)

Define parents (born same 
year so cannot be parents of 
each other, avoid multiple 
generations)

http://familias.name/ESWG/ESWG_Paper_challenge_2021.pdf
http://familias.name/ESWG/kling_eswg2021_pt_test.mp4
http://familias.name/ESWG/ESWG%20-%20Proficiency%20test%202021.pptx


Generate pedigrees
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Question: What is the relationship between four children? 
Full siblings, half siblings or unrelated?

Generate options.
a) Include extra males/females (not 

recommended)
b) Remove redundant pedigrees 

(recommended)
c) Peel single parents (recommended)
d) Peel single children (recommended)
e) Disregard genders (optional)

Generate pedigrees



Generate pedigrees
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Question: What is the relationship between four children? 
Full siblings, half siblings or unrelated?

Familias will generate all possible pedigrees with restrictions 
imposed by the defined persons and options. It will also, for 
example, generate pedigrees where an individual has a single 
parent, both not genotyped. This is removed with the two 
peel options given. Disregard genders option will consider 
maternal and paternal half siblings as identical and will thus 
consider such events as duplicates.

You can restrict the number of pedigrees generated if some 
relations are known in the ‘Known relationship’ window:



Generate pedigrees with restrictions: example
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The “Generate” function by default (without restrictions) gives
the 12 pedigrees to the left (input file peel.fam)

● Recommended restrictions 
○ Remove redundant
○ Peel single parents
○ Peel single children

give the pedigrees 1, 3, 6, 8, 10 ,12
● Inbreeding parameter 0 gives 0 likelihood for pedigrees 

8 and 12.

https://familias.name/tutorial/peel.fam


3. R Familias, paramlink and plotting

30Familias - Tutorial



What is       ?

• A framework for statistical and numerical computing

– calculator

– flexible plotting

– large core of functions for data handling and numerical analysis

– programming language

– external packages

• anyone can make one

• thousands! 

• About R:

– it's freely available from https://cran.r-project.org/

– it's widely used

– it can do anything (but it may not be easy)

31Familias - Tutorial

https://cran.r-project.org/


Installing and loading the R library Familias

To access the functions of an external library, exemplified with Familias below, you must:

• install the package, this done only once. On most platforms the following will work

(further details are  here): 
� install.packages("https://familias.name/RFamilias/Familias_2.5.zip", repos = NULL, type = "win.binary")   

#(internet connection needed) 

• load it into R every new session:

� library(Familias)

To obtain help, enter

�  help(Familias)

32Familias - Tutorial

https://www.familias.name/openfamilias.html


Sample session from help ("FamiliasPosterior"): 
copy and paste to R!
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library(Familias)
persons <- c("mother", "daughter", "AF")
ped1 <- FamiliasPedigree(id=persons, dadid=c(NA, "AF", NA), momid=c(NA, "mother", NA), 
                         sex=c("female", "female", "male"))
ped2 <- FamiliasPedigree(id=c(persons, "TF"), dadid=c(NA, "TF", NA, NA), 
                         momid=c(NA, "mother", NA, NA), 
                         sex=c("female", "female", "male", "male"))
ped3 <- FamiliasPedigree(id=c(persons, "TF", "gf", "gm"), dadid = c(NA, "TF", "gf", "gf", NA, NA), 
                         momid=c(NA, "mother", "gm", "gm", NA, NA), 
                         sex=c("female", "female", "male", "male", "male", "female"))
X11()
plot(ped1);title("ped1, i.e., AF is father")
mypedigrees <- list(isFather = ped1, unrelated=ped2, isUncle = ped3)
locus1 <- FamiliasLocus(frequencies=c(0.1, 0.2, 0.3, 0.4), 
                        allelenames= c("A", "B", "C", "D"), name="locus1")
locus2 <- FamiliasLocus(c(0.2, 0.3, 0.5), c(17, 18, 19), "loc2", femaleMutationRate = 0.05)
myloci <- list(locus1, locus2)
datamatrix <- data.frame(locus1.1=c("A", "A", "A"), locus1.2=c("B", "B", "C"), 
                         locus2.1=c(17, 19, 19), locus2.2=c(18, 18, 18))
rownames(datamatrix) <- persons
result = FamiliasPosterior(mypedigrees, myloci, datamatrix,ref=2)
result



R code generated from Windows Familias
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• Familias exports to R for

✔ Plotting

✔ Conditional simulation

✔ Probability of  exclusion

✔ …
• Export is done from within Windows Familias;

✔  File >  Export to R-Familias (complete export)

✔ ‘Plot in R’ in Edit Pedigree window (only plot)

✔ Conditional simulation in DVI module



4. Simulations
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Simulations
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Click 

1

2

5

• In the Pedigrees window (      )  , once you have defined the hypotheses you want to 
simulate, click ‘Simulate’ (      ). The Simulation window opens.

• Select the individuals that will be genotyped (      ) by clicking on them and then on the 
arrows (      ). The individuals will be moved to the “will be genotyped” box (      ).

1
2

3
4 5

3

4



Simulations - Options
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You can choose the number of simulations (1000 by default) 1

You can save the raw data (genotypes and/or LRs) in a .txt file2

You can perform simulations with either all markers in the 
frequency database or only the ones selected in the 
Pedigrees dialog (Included systems) 

3

You can specify where the simulations will start (Seed). 4

Click ‘Simulate’ 5

If “Random seed” is used,  
different simulations will be 
obtained  each time you 
simulate.

If “Random seed” is unclicked, you 
have to enter a number, and you 
will obtain exactly the same 
results each time (given that all 
other values/parameters remain 
unchanged and using always the 
same seed number). 

1
2

3

4

5



Simulations - Results
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Meaning of first line in the figure (H2: “AF and CH are unrelated” IS TRUE): 
LR values = 0 are not expected as a mutation model is used (stepwise stationary, rate 0.001 and 
range 0.1) in the example.  However, low LRs are generally expected as the true hypothesis is 
unrelated.
The mean of the obtained LR values is 0.99
50% of the simulations are below (and above) the median 0.7715
95% of the simulations are below 2.746
5% of the simulations are below 0.0003981

Meaning of line two in the figure (H1: “AF is the father of CH” IS TRUE):
The mean of the obtained LR values is 1.874
50% of the simulations are below the median 1.54
95% of the simulations are below 4.008
5% of the simulations are below 0.6872

Comment
The LR values under both situations (H1 true 
and H2 true) overlaps. So, we will not be able 
to reach any conclusion about paternity if only 
these 2 markers (with 3 and 2 alleles) are 
analysed. 

You can use this file to reproduce these 
results

http://familias.name/tutorial/example-tutorial.fam
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Simulation – A “more real” example

Meaning of first line in the figure (H2: “AF and CH are unrelated” IS TRUE): 
LR values = 0 are not expected as a stepwise stationary mutation model with mutation rate 0.001 
and range 0.1 was used in the example.  However, very low LRs are expected given that unrelated 
is the true hypothesis.
The mean of the obtained LR values is 1.018e-09
50% of the simulations are below the median 4.051e-31
95% of the simulations are below 8.159e-17
5% of the simulations are below 2.145e-47

Meaning of line two in the figure (H1: “AF is the father of CH” IS TRUE):
The mean of the obtained LR values is 6.317e+08
50% of the simulations are below the median 4.418e+06
95% of the simulations are below 1.101e+09
5% of the simulations are below 3.319e+04

Same hypotheses, same simulation options (1000 simulations, all markers, Seed 12345), but 16 
aSTR markers with real allele frequencies (PP ESX17)

Comment
The LR values under both situations 
(H1 true and H2 true) DO NOT overlap. 
So, we will  be able to reach a 
conclusion about paternity

You can use this file to reproduce 
these results

http://familias.name/tutorial/simu-16markers.fam


Simulations – LR limit
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Useful to display results in a way that may be easier to understand
The LR limit button is used to find the fraction of simulations exceeding an LR threshold

1

4

2

3
• Click on LR limit (      ). The “Simulation 

limits” window opens.
• Select your LR threshold (      ), 1000 for 

instance, and click “Update” (      ). 
• You will obtain the info in         .

1

2
3

4

Meaning
If your LR threshold = 1000, no false 
positives are expected if you analyze 
16 markers. False negatives are very 
low (since 99.8% of simulations  gave 
LRs ≥ 1000)

False positive means LR ≥ 1000 if H2 is true
False negative means LR ≤ 1000 if H1 is true



Simulations - Further
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• We recommend at least 1000 simulation to obtain an idea of the LR distribution. 
However, to explore more extreme possibilities, a much greater number of 
simulations should be performed, for instance 100,000.

• We recommend to use random seed in the general simulation scenario whereas a 
fixed seed (say 12345) should be used when results need to be reproducible, for 
instance in connection with a publication.

• Hint: The raw exported genotype data may be used as input in Familias. For 
instance, if simulating data for a DVI test scenario (see Section 6), data for families 
may be simulated and used as a starting point.

• For plotting purposes (or other uses) the raw LRs from the simulation can be 
exported from the Results window. We recommend to use the logarithm of the LR 
as the resulting distribution is approximately Normal. See next slides for some 
examples.



Plotting simulations I. Commands in Familias
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• Download the file in
http://familias.name/tutorial/Basics-sim.fam 
and perform 100 simulations using the following options

http://familias.name/tutorial/Basics-sim.fam


Plotting simulations II. Excel
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• The output file can be explored in Excel (and plotted, if you are an expert in Excel) 

• Data may be arranged in Excel (the Data > filter option may be useful)



Plotting simulations III. Data organised for R.
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• Plotting and further analysis can be done in Excel (not explained here).
• We rather use R and save the above file as a tab delimited file called Sim.txt

� Variable names need to comply with R requirements 
(for instance, ‘TRUEPED’, not ‘TRUE PED’)

� Value of variables also need to comply with R requirements:
We can use e.g. ‘H1.father’ but not say ‘H1:father’ or ‘H1 Father’.



Plotting simulations IV. Using R
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dat = read.table("http://familias.name/tutorial/Sim.txt", header = TRUE)
summary(dat) # Check data
dat = dat[dat$TRUEPED == "H1", ] #Extracts data for hypothesis H1
summary(dat)
logLR = dat$logH1 - dat$logH2 # Calculates log (=ln , i.e., base=e) of LR
hist(logLR, xlab = "logLR", ylab = "count",  main ="logLR (lnLR)") 
boxplot(logLR, ylab ="logLR")
LR = exp(logLR)
hist(LR, xlab = "LR", ylab = "count ", main ="LR") 
boxplot(LR, ylab ="LR")

• We provide an example for plotting in R, with the file already in it’s correct format.
• You can copy and paste the following commands in R, but internet connection is required 

since the file of interest is in the link of the first command line: 

http://familias.name/tutorial/Sim.txt


Plotting simulations V
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• 1000 simulations are saved based on analysis using
http://familias.name/tutorial/Siblings-sim.fam

We do not tick the ”Save raw data” option in this window!

http://familias.name/tutorial/Siblings-sim.fam


Plotting simulations VI
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# First, density plot (log LR distributions), running this code requires an internet connection
dat = read.table("http://familias.name/tutorial/Sim2.txt", header = FALSE, skip=5)
plot(density(log10(dat$V1)), xlab= "log10 LR", ylab= "Density", col=1, lwd=2, main="", xlim=c(-20,20), ylim=c(0,0.2))
points(density(log10(dat$V2)), col=1, lty=2, lwd=2, type= "l")
legend("topright", c("H1: Siblings", "H2: Unrelated"), lwd=2,lty=1:2)
# Next exceedance plots, i.e. the probability to exceed each threshold given each hypothesis
dev.new()
threshold <- exp(seq(log(0.01), log(20), length.out=1000))
eh1 = eh2 = threshold
for (i in 1:1000) { eh1[i] = sum(log10(dat$V1)>threshold[i])/1000; eh2[i]= sum(log10(dat$V2)>threshold[i])/1000; }
plot(x=threshold, y=eh1, lwd=2, ylab= "Exceedance probability" ,xlab= "log10 Threshold" , type= "l")
points(x=threshold, y=eh2, lwd=2, lty=2 , type= "l")
grid(); legend("topright", c("H1: Siblings", "H2: Unrelated"), lwd=2,lty=1:2)

• Data saved to file Sim2.txt and processed as shown below
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Plotting simulations VII
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Meaning
After 1000 simulations:

- the values of the LRs if H2 is true range 
from 10-20 to 105 (more or less)

- the values of the LRs if H1 is true range 
from 10-5 to >1020 

The probability that LR(unrelated) is 
larger than LR(sibs) is fortunately small, 
and estimated in R to be 0.002 (2 of 1000 
simulations):

sum(dat$V2 > dat$V1)/1000

Data for plotting: http://familias.name/tutorial/Sim2.txt

http://familias.name/tutorial/Sim2.txt


Conditional Simulations I
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• The genotypes of the typed individuals are taken into account.
• Very useful for DVI since specific reference genotypes may determine how 

informative a pedigree is. 
• Example: the reference is the father and the child is the missing person. If the 

genotype of the father is rare, simulated LRs will tend to be larger than if the 
father’s genotype is common.

• Only genotypes compatible with the father will be simulated

Father

D3S1338 14-16

D3S1338 Simulated child

Simu1 14-14

Simu2 14-16

Simu2 16-17

… …

Only genotypes with 
alleles 14, 16 or both 
will be simulated
The LR for each 
simulated genotype is 
then calculated



Familias - Tutorial 50

Conditional Simulations II

Open the Simulation window from the pedigrees window
Activate conditional and select the target (child CH in this case)
Press Simulate

1

1

2

2

Note: Familias will only simulate data for the target given the already defined genotypes! The option to 
include/exclude persons is unavailable (the Will be genotype/Not genotyped lists are grey)

Use data in file http://familias.name/tutorial/cond-simu-father-child.fam

http://familias.name/tutorial/cond-simu-father-child.fam


Conditional Simulations III
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An R-script will be generated.
Copy and paste the script in R



Conditional Simulations IV
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The results will appear in the Familias screen



5. Blind search
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Input file: tutorial-Ch5.fam

http://familias.name/tutorial/tutorial-Ch5.fam


Purpose

• Find the pairwise relationships between DNA profiles. 
– Simple case:

• With the above profiles, we can do the following six comparisons
– P1-P2, P1-P3, P1-P4, P2-P3, P2-P4, P3-P4

• ‘Blind’ implies that some fixed relationships are searched (as opposed to explicitly 
specifying pedigrees) namely

– Parent-Child, Siblings, Half-siblings, Direct-match, Cousins, 2nd cousins

• We could e.g. guess that P1-P2 is most likely a ‘Direct-match’ (from the same 
person). However, other relationships are also possible, but less likely.
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How to do Blind Search - Preliminaries
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1 2

3

• Define General DNA data        , Persons          and Case DNA data  1 2 3
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The search
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1

2 4

3

5

• The search is initiated         (alternatively Blind search can be done in the DVI and Familial 
Searching modules; then only step         of previous page is done before entering these modules)

• Parameter settings:
✔ LR exceeding 0 will be reported (default is 1) 
✔ Theta, default 0 is used
✔ Desired comparisons       . Here: Parent-Child, Siblings, Half-siblings
✔ Compare against unrelated (denominator of LR)

1

2
3

4
5

1

Familias - Tutorial



Basic output

57

• Three relationships are studied, and there are six pairs for each, 
so the list contains 3*6=18 comparisons.

• The list is sorted according to LR.
• Inconsistencies are only possible for ‘Parent-Child’ and these are indicated
• Mutations are accounted for in the  Blind search in the DVI module only for 

‘Parent-Child’
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Direct match

• For Direct match, additional parameters can be set
– Dropin param.        ,  Dropout          and Typing error         . Output below for parameters equal 0.

– The P1-  P2 LR is now reduced to 9.6 while the other comparisons now give LR > 0.

58

1

2

3

1 32
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Advanced options and output

• There are several further options, most of them are intuitive and not needed for 
simple applications.

• There is also more advanced output like information on IBS (Identical By State)
alleles and IBD (Identical By Descent) alleles. This output is not relevant for 
standard applications.

59Familias - Tutorial



6. DVI (Disaster victim identification)
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Some more advanced features of DVI, including simulation and 
working with separate databases of allele frequencies, are 
explained in here.

Input file for most examples that follow: Exercise.3.1.fam. Some 
screen shots and output differ slightly (insignificantly) from 
most recent version of Familias.

https://familias.name/tutorial/getting_started_Familias_DVI.pdf
https://familias.name/tutorial/Exercise.3.1.fam
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1. General DNA data. Input of database, i.e., allele frequencies, etc. Described in 
detail in Section 1. 

2. Unidentified samples.  Samples to identify, in a DVI operation this is a set of 
unidentified remains whereas in some missing person scenarios it may also be 
identified individuals where the aim is to reunite with biological family.

3. Reference families. Reference data used to identify and reunite families with 
missing persons.

4. Search. Perform and interpret the results.

Basic steps



DVI illustrated
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1. General DNA data: 
A marker with alleles 1 ,2, 3, 4 (all with freq = 0.25)

2. Unidentified samples: 
Three samples V1, V2 and V3 and their genotypes.

3. Reference families: 
Two reference families F1, F2 with missing 
individuals (sons here) M1 and M2.
Marker data for available relatives 
(mother and father for F1, only father for F2.)

• We next illustrate manual input for this toy example 
with manual input; this  is a useful exercise.

• For real cases, data will be imported from files and
this is explained  at the end of this section.
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How to do DVI
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1

2a

Define marker       , enter DVI module > Add              
and input unidentified samples               . Press Next 

1 2a

2b 2c

Familias - Tutorial

2c

2b

Comment
The “Is entity?” 
option is in Beta 
testing and 
allows the user 
to specify a 
family/pedigree 
instead of an 
unidentified 
person



Defining reference families
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3a

3b

3c

• The first family has been defined, we
press ‘Add’             to  enter a new family.

• We name the family
• We enter the persons needed to 

define the pedigree and the 
genotypes if available 

3a

3b

3c

Comment
In these windows you have to define the 
name of the family, the members and the 
DNA data (relationships between them 
and the missing person are not defined 
here)



Defining pedigrees, i.e.,  how MP is related
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3c

3f

3g

• We go Add              to define the pedigree
• We name the pedigree
• We define how MP is related with this family
• We don’t touch the ‘Reference pedigree’,             ,

it’s there since a MP may not belong to any reference family.
• When input is finished, we press ‘Next’ to do the search ….
• Note: In order to define a direct reference samples (e.g. personal belonging), 

press Direct match                when adding relation

3e

3c

3d

3f

3d

3e

3g



The DVI search
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• We press search
• Choose options              Here Threshold/limit is 0, so we see all results
• Posterior model:              

○ AM driven: each family treated separately 
○ PM driven: each person treated separately
○ One-to-one: only two hypotheses

• Note: priors and posteriors are not applicable when the Quick scan is 
performed but will still be displayed.

4b

4a

4c

4b

4c

4a

see next slide
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Output for AM driven posterior model
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• The first family (here F1) is analysed first.
• The LR = P(marker data| MP belongs to F1)/ P(marker data| MP is not related to F1)

is found for all unidentified samples.
 For V1 and V3, LR = 0, while for V2, LR = 1/(2*0.25*0.25) = 8.

• For the posterior we need a prior. Here we assume that a priori V1, V2 and V3 have a 
prior of 0.25 to belong to F1; the missing person may be someone not found with prior 
0.25. The posterior probabilities are 
P(V1 from F1) = 0, P(V2 from F1) = 0.89, P(V3 from F1) = 0, P(Unknown from F1) = 0.11.

• Remaining families, here only F2, are treated similarly.
Familias - Tutorial



How Familias set priors
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- By default (Use list), Familias takes into 
account the number of unidentified samples 
(3 in this case) and  also adds the possibility 
that the missing person was not found: 1 / 4 = 
0.25 (as was shown in previous slide). The 
text “Use list” is replaced by “Use #PM” in 
recent versions.

- You can also unclick “Use list” and add the 
size you want. For instance, if in this case we 
knew that at least there are 4 victims 
(although only 3 were found), we can add “4” 
in the size box. Then, prior will be 1/5= 0.20, 
for each victim. 

In the “Add unidentified person(s) (PM)” window



Further: unidentified persons – comparisons
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1

2
3

Very useful to re-associate human remains (from the same individual) and/or detect 
possible relationships among victims
Example:
Add  a new human remain V4 with the same profile as V1 (M1 = 2/3) in the “Add 
unidentified persons” window        and click “Blind search”.  Press “New search” and 
select the “Direct match” relation vs. “unrelated” to obtain         . Select the samples and 
Click “Merge samples”

1
2

3
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Merging samples 

1
4

2

3
You will obtain a summary of the samples. 
In the “Options” menu you can select: create a composed profile       
(combine both option), use profile from V1 or use profile from V4. You 
can also rename this combined profile        .
Click “Merge”        and the composed sample V1_V4 will appear now in 
the “Unidentified persons” window 

1
2

3
4

Comment
In this example V1 and V4 have the same 
profile, but in real cases it is possible that 
one of the samples is incomplete. This is the 
reason why the option “Combine both” is 
available.
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Further - Reference families 

You can search only the selected families
Perform global search (not yet available)
Prepare plots in R for selected families
Evaluate the reference families, simulations
as well as other summary statistics

1
2
3
4



DVI with import from files

• Start Familias and import the frequency database:
– Tools > General DNA data file: http://familias.name/tutorial/database-dvi-tutorial.txt

• Read in the unidentified samples:
– Tools > DVI module > Add  Unide…  file: http://familias.name/tutorial/unidentified-dvi-tutorial.txt

• Option 1:  Read reference persons with marker data  and enter pedigrees manually
– Tools > DVI module > Add refe … Data only 

file: http://familias.name/tutorial/ReferenceFamilies-dvi-tutorial.txt

– Define pedigrees manually

• Option 2: Read all input for reference families
– Tools > DVI module > Add refe … Multiple families

file: http://familias.name/tutorial/pedigrees-dvi-tutorial.txt

• The search can be done next giving results as before. Further details on import files 
are in Section 8 below.
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Note: you can copy and paste the 
links in your browser and then save 
the files by using Ctrl+s keys of your 

keyboard 
Ctrl+s

http://familias.name/tutorial/database-dvi-tutorial.txt
http://familias.name/tutorial/unidentified-dvi-tutorial.txt
http://familias.name/tutorial/ReferenceFamilies-dvi-tutorial.txt
http://familias.name/tutorial/pedigrees-dvi-tutorial.txt


7. Familial searching
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1. General DNA data. Input of database, i.e., allele frequencies, etc.
2. Profile database.  Individuals/traces in the offender database.
3. Traces. Traces to perform the familial search on
4. Search. Perform and interpret the results from a familial search

Basic steps



Familial searching illustrated
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1. General DNA data: 
A marker with alleles 1 ,2, 3, 4 (all with 
Freq.=0.25).

2. Offender database: 
Three samples S1, S2 and S3 and their 
genotypes.

3. Target profile: 
A trace T1 with a genotype that does not fully 
match any of the offenders’.

• We next illustrate manual input for this toy example 
with manual input; this  is a useful exercise.

• For real cases, data will be imported from files and
this is explained  thereafter.  Familias can handle databases of > 300,000 samples.

S1

S2

S3

2/3

1/3

4/4

T1

3/3

Familias - Tutorial
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How to enter profiles in this module

C

A

Select the first offender/trace and click «Edit DNA» to enter the profile
In Familial Searching module, profiles are entered in a different way (since you may need to add more 
than two alleles for DNA mixtures)
To enter S1=2/3, you have to:
- Select «Allele 1» in the dropdown menu           and then select the value         of this first allele (2, in 

this example). Do not press Add just yet
- Select «Allele 2» in the dropdown menu and then select the value of this second allele (3, in this 

example). Now, press Add to obtain         . C

A B

B

Familias - Tutorial



Defining the offender database
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1

Define marker       , enter Familial searching module
 Add persons and database profiles              Press Next 

1 2a

2b 2c

2a 2c
2b

Edit DNA 



Defining target(s)
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• Define the target, in this case a trace.
Press ’Add’ 

• Edit DNA data as indicated
• We may set known contributors (e.g. 

Victims in mixtures)

4a

4b

4c

4a

4c

4b



Defining search options
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• We specify Parent-child               as the relationship we want to include in the search.
• We set the LR threshold to 0 (zero)               and leave the other parameters at their 

default values.
• Press ’Next’

5b

5a

5c

5a

5c

5b

Familias - Tutorial



Advanced options
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• We can use an IBS filter               to remove matches with low IBS sharing
• We can select Examine kinships               to have Familias perform a grid search over a 

small space of possible k0, k1 and k2 values. Computer intense and only performed for 
relationships exceeding the LR threshold.

5e

5d

Familias - Tutorial

5d

5e



The familial search - Basic results
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6a

6c

6b

6d

• We press ’Search’
• The results are displayed as matches between a Profile/Trace (target) and a Candidate 

(database element). Results are sorted according to the LR value. In addition some 
other metrics are displayed.

• The results may be investigated closer               and some reports may be created     .

6a

6b

6c 6d



The familial search - Advanced results
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• By scrolling to the right you will see some other stats from the search. 
• Shared alleles (total) as well as fraction of markers with 0, 1 or 2 alleles IBS
• If Examine kinships is activated in the search options, a grid search is performed where 

the most likely IBD values are reported as well as the kinship coefficient.



Familial search with import from files

• Start familias and import the frequency database:
– Tools > General DNA data file: http://familias.name/tutorial/database-dvi-tutorial.txt

• Import the offender database
– Tools > Familial searching > Import file: http://familias.name/tutorial/offenders-fs-tutorial.txt

• Import the target profile
– Tools > Familial searching > Next > Import

file: http://familias.name/tutorial/target-fs-tutorial.txt

• The search can be done next giving results as before. Further details on import files 
are in Section 8 below. Familias handle standard xml output from the CODIS 
software.
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Recall: you can save the above files by using 
Ctrl+S keys of your keyboard in your internet 

browser once you have followed the link

http://familias.name/tutorial/database-dvi-tutorial.txt
http://familias.name/tutorial/offenders-fs-tutorial.txt
http://familias.name/tutorial/target-fs-tutorial.txt


8. Input files (formats)
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8.1 Frequency database input
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The standard format is recognized by all versions of Familias and is described 
below. It is saved as a text file.

Standard (tab separated)
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The matrix format is commonly attached to population frequency 
publications. Important is the Allele or Alleles identifier in the top left 
element.

Matrix format



8.2 Case data input (samples)
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Tab separated files are most easily created in Excel (or a similar tool) and 
saved as text file with tab separation. Below is an example of the format.

Tab separated 1
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Familias also allows tab separated text files with single column markers. 
The format is described below.

Tab separated 2
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Familias can import data from the genotyper software GeneMapper (or data 
on similar format). The format is described exactly below.

GeneMapper
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Familias recognizes xml input based 
loosely on the CODIS format. An 
example of the format is described 
to the right where the necessary 
tags are defined. Additional tags 
(normally added by CODIS) are 
disregarded.

An example is located at 
http://familias.name/Files/example.xml

XML input

http://familias.name/Files/example.xml


8.3 Reference family data (DVI)
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Familias recognizes some standard relationships for the subsequent import 
options. Below is an exhaustive list. Please check all imported data to 
assure Familias has made the correct interpretation. Here’s an example 
file from the DVI section, more examples follow.

[Father], [Mother], [Parent], [Son], [Daughter], [Child], [Sister], [Brother], 
[Sibling],  [Half Sister], [Half Brother], [Half Sibling], [Direct], [Identity], 
[Paternal Half Sister], [Maternal Half Sister], [Maternal Half Brother], 
[Paternal Half Brother], [Grandmother], [Grandfather], [Paternal 
Grandmother], [Maternal Grandmother], [Paternal Grandfather], 
[Maternal Grandfather], [Grandson], [Granddaughter], [Grandchild], 
[Uncle], [Aunt], [Niece], [Nephew], [Wife], [Husband]

Relationships

https://familias.name/tutorial/pedigrees-dvi-tutorial.txt
https://familias.name/tutorial/pedigrees-dvi-tutorial.txt
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Similar to the tab separated files described 
previously for standard DNA data input. Several 
individuals may be included in the same file. 
Note, no family information can be included, 
each individual is placed into a single family. A 
line specifying a relation may be included, see 
below.

Simple
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The format is described previously for standard DNA data input. This version 
will however recognize CODIS categories and create some family 
relationships based on those.

CODIS xml
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This format reminds of the Simple format but adds a column to define family 
designation, see below.

Data only
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This format extends the Data only format but including an additional column 
specifying the relationship to the missing person within each family, see 
below.

Multiple families
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This option allows the import of standard Familias project with some DNA 
data and pedigrees. Familias will automatically create families (one for 
each Familias file). The missing person should be named MISSING 
PERSON.

Familias projects



9. Output files and reports
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9.1 Reports from Familias
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This is the standard output from Familias, i.e.,  the so called Familias report. It 
may be generated using different scopes, the simple containing only 
information about the LRs and pedigrees and the most extensive 
containing all information needed to reproduce the results.

The file is actually generated as a txt file with the rtf extension and is 
therefore not a true rich text formatted file.

rtf format
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This format will generate a comma (semicolons) separated file (csv). Output is 
illustrated below.  

csv format
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This format will generate a tab separated file. Output is illustrated below.  

tab format
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This format will generate an xml file with comprehensive content. This file 
may actually be opened as a project as well. An excerpt is illustrated 
below.  

xml format
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This format will generate a tab-separated text file listing all the pedigrees as 
well as likelihoods, LRs and posteriors (if available)

Pedigree list



9.2 Other
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Several dialogs/windows allow the export of the complete table of results, 
e.g. DVI search results. The output is simply a tab separated txt file that 
may be processed further in Excel or similar software. 

Those exports are self-explained.

General output
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Several dialogs/windows allow the export of summaries, i.e., the blind search 
module allows the user to generate a summary of the results from a 
search, as does the DVI search function.

Summary reports
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The blind search module allows the export of a distance matrix. The matrix 
will be of n x n dimensions where n indicates the number of individuals in 
the blind search. The matrix will compare all individuals and compute 
either,

1. A IBS distance between the two genotypes
2. The kinship coefficient, estimated using a maximum likelihood approach
3. The kappa2 and kappa0 estimates, using the same method as in 2.

Export matrix



10. Advanced
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There are some advanced options/settings in Familias reached via 
File -> Advanced, see illustration on next page. Some of the settings are 
intended for expert users.

Description
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View mutation matrix – View and/or save the mutation matrix for the defined markers/systems.
Save genotype data – Decide whether or not to save the raw genotypes from a simulation
Save complete data – Decide whether or not to save all raw data (genotypes and likelihoods) from a simulation
Dropout – Enable a logistic dropout model whereby allele peak heights are needed (may be imported using the Genemapper format 

only). Recommended for advanced uses only.
Step dropout probability – If enabled together with dropout for a profile, Familias will compute the LR for a range of dropout 

probabilities (similar to a sensitivity analysis). 
DVI  options – By default a quick search feature is enabled whereby Familias first computes the LR disregarding mutations and then with 

mutations for markers where the likelihood is zero.  Set the number of allow mismatches for Familias to even consider a 
computation. Disabling this feature may cause extensive computation time.

Number of decimals – Set the number of decimals to display and save when numbers are relevant.
Force minor allele frequency – If enabled Familias will force the use of the minor allele frequency (defined for each marker) whenever an 

allele frequency is below this value. Warning! May cause the sum of allele frequencies to sum to more than 1.
New alleles - Remember choice whenever a new allele is detected. For instance, the same frequency to all new alleles.
Debug mode - This will turn on some debug options, mainly through dumping files into the Familias install directory.
Direct/Identity matches – The values used in a direct match comparison. May also be changed in the blind search dialog.
Allele lumping – Not currently implemented. If enabled it will cause lumping of alleles which in turn will produce much shorter 

computation times. The lumping is an approximation whereby all transitions/mutations with a probability lower than the threshold 
is lumped.



11. Miscellaneous
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● File > Create database can be used to
○ create a database of allele frequencies
○ provide summary statistics, like heterozygosity
○ perform a blind search with the profiles of a population study 

● A toy example (file) based on a sample of ten individuals for two markers

● Import: File > Create database > Import
● Create Familias file: File > Create database > Create
● Produce statistics: File > Create database > Statistics

The file contains statistics at bottom and can also be imported to Familias
● Perform a blind search: File > Create database > Check data

Create a frequency database
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https://familias.name/tutorial/database-creation-example-small.txt


More information: 
http://familias.no, http://familias.name and in 

the books:
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Relationship inference Mass Identifications

http://familias.no/
http://familias.name/
http://store.elsevier.com/product.jsp?isbn=9780128024027
https://www.elsevier.com/books/mass-identifications/kling/978-0-12-818423-3


Useful links
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Databases (ready to use):

- Norwegian

- Somali: Northeast Africa (Somalia, Ethiopia, Eritrea)
- Middle Asia (Pakistan/Afghanistan)
- Southeast Asia (Thailand, Vietnam)
- Spanish 

Elias Hernandis has created a great tool to convert and produce 
data files for Familias (and other software). See 
https://leapdna.org/. 

http://familias.name/Familias_databases/Norwegian_DB.fam
http://familias.name/Familias_databases/Somali_DB.fam
http://familias.name/Familias_databases/Somali_DB.fam
http://familias.name/Familias_databases/Middle_Asia_DB.fam
http://familias.name/Familias_databases/Southeast_Asia_DB.fam
http://familias.name/Familias_databases/Spanish_DB.fam
https://leapdna.org/


Papers referencing Familias. Validation
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• It may be helpful to check papers that reference Familias
• An updated, but not exhaustive list, can be obtained by  checking to 

– References to Egeland et al.(2000)
– References to Kling et al. (2014)

• Kinship software, including Familias, was validated in
– Drabek (2008)

https://scholar.google.com/scholar?cites=16640506541668228170&as_sdt=2005&sciodt=0,5&hl=en
https://scholar.google.com/scholar?cites=971745121205496116&as_sdt=2005&sciodt=0,5&hl=en
https://pubmed.ncbi.nlm.nih.gov/19215880/

